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TIBCO Enterprise Runtime for R Release Notes

The Release Notes for this product version are provided to inform you of new features, known issues,
and issues from previous releases that have been closed.

These release notes are for TIBCO® Enterprise Runtime for R (TERR™) version 6.0. They cover Linux®

and Microsoft Windows® installations.

(As of version 6.0, TERR is deprecated on macOS and is no longer tested.)

TERR™ is a high-performance statistical engine, which is compatible with open-source R. It can be
embedded into a wide range of applications as an enterprise-grade alternative to open-source R, and
can run a wide array of packages from CRAN.

This release of TERR focuses on improving compatibility with open-source R.

Open-source R is available under separate open source software license terms and is not part of
TERR. As such, open-source R is not within the scope of your license for TERR. Open-source R
is not supported, maintained, or warranted in any way by TIBCO Software Inc. Download and
use of open-source R is solely at your own discretion and subject to the free open source license
terms applicable to open-source R.

New Features

Version 6.0 of TERR contains the following new features.

Version 6.0.1

Version 6.0.1 of TERR contains no new features.

Version 6.0.0

TERR version 6.0.0 has changed to accommodate the changes made to open-source R version 4.0.2.

New implementation for R 4.0.2 compatiblity
TERR has new functions and changes to existing functions and behavior to match new functions and
changes in open-source R 4.0.2.

rtools40 compatibility
TERR has been tested with the rtools40 utilities for building packages with C code under Windows.

Other improvements
TERR CMD config now supports the RANLIB and AR make variables and the C++ related variables for
C++20 (similar to the ones for 11, 14, and 17).

New functions and RAPI entries in TERR 6.0.0

TIBCO® Enterprise Runtime for R Release Notes
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New functions in included packages

Package Name Details

base
activeBindingFunction(sym,
env)

 

This function retrieves the function for the active binding, the fun
argument to makeActiveBinding(sym,fun,env).

base
chkDots

 This function warns the user if unrecognized arguments are passed
using the ... formal argument.

base
deparse1

This function is like deparse(), except that it always returns a
single (perhaps long) string. This function was added to open-
source R 4.0.0.

base
globalCallingHandlers

This function is used for establishing session-wide condition
handlers. This function was added to open-source R 4.0.0.

base
hasName(x, name)

This function is equivalent to is.element(name, names(x)).
 Given an object and a name, this function returns if the object has
the name.

base
infoRDS

This function provides details about an RDS file made by saveRDS(
).

base
...names

This function returns the names attached to the ... arguments in
the call to a function calling ...names(). This function was added
to open-source R a short time after the release of open-source R 4.0.
0.

base
numToBits
numToInts

These functions inspect the bits in double-precision numbers. These
functions were added to open-source R after the release of open-
source R 4.0.2.

base
str2expression
str2lang

These functions provide convenient interfaces for parsing strings
into expressions and language objects, respectively.

base
suspendInterrupts(expr)
allowInterrupts(expr)

These functions execute an expression while suspending or
enabling user interrupts. Finalizers are now executed with
interrupts suspended.

base
tryInvokeRestart

This function behaves the same as invokeRestart, except that it
silently returns NULL instead of generating an error if the named
restart is not found. This function is called in various system
functions, preventing errors in some cases. This function was added
to open-source R 4.0.0.

base
valid.factor(object)

This function was added to open-source R 3.4.0.

base
withAutoprint

This function is an alternative interface to the source() function,
 with defaults set to emulate the usual parse-evaluate-print loop
used in the command line interface. This function was added to
open-source R 4.0.0.

methods
el
el<-

These functions have been implemented because they are used
by the networkDynamics package. They are wrappers for other

TIBCO® Enterprise Runtime for R Release Notes
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Package Name Details

operators for backwards compatibility and should not be used for
new code.

stats
DF2formula

This function was added to open-source R 3.6.0.

tools
package_native_routine_
registration_skeleton

This function creates a C code file that registers the compiled
routines in a package.

tools
R_user_dir

This function gives standard locations for user- and package-
specific directories in which package writers can store folders, files,
 and objects. This function was added to open-source R 4.0.0. 

tools
vignetteInfo

This function parses the %\Vignette* entries in the source file of a
vignette.

utils
isS3stdGeneric(f)

This function tells if the function f is a call to UseMethod().

utils
packageDate

Given a package name, this function returns the date the package
was created or built.

New R C API Entries

The following R C API entries are implemented to improve package loading and compatibility. For a
complete listing of the Rapi C API entries implemented in TERR, run the following.

library(terrUtils)

implementedRapiEntries()

R C API entries Description

CAR0
This RAPI entry is required if you use the Rcpp library built for open-
source R 4.0 to load into TERR.

Rf_lgamma
This RAPI entry computes log(gamma(1+x)) accurately for small
abs(x).

EXTPTR_PTR
This RAPI entry is used by the Rcpp packages in open-source R 4.0.2.

R_ActiveBindingFunction
This RAPI entry has the same behavior as the open-source R function
activeBindingFunction().

This RAPI entry was added to open-source R 4.0.0.

R_ContinueUnwind
R_MakeUnwindCont
R_UnwindProtect

These RAPI entries are now fully implemented to correctly facilitate
unwinding an error and continuing error processing using a
continuation object.

TIBCO® Enterprise Runtime for R Release Notes
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R C API entries Description

GEStrMetric 
This RAPI entry is required for the systemfonts package to be loaded.
 GEStrMetric is not functional, so calls to it do not give expected
results; Calls to it result in a warning.

R_removeVarFromFrame
This RAPI entry is used for removing a variable from an environment.
 This is useful because Rf_defineVar can no longer be used to remove
a variable from an environment.

This function was added to match the implementation in open-source
R 4.0.0.

R_RestoreHashCount
This RAPI entry is needed to load the qs package.

R_tryCatch
R_tryCatchError

These RAPI entries were added to open-source R 3.4.0.

R_withCallingErrorHandler
This RAPI entry was added to open-source R 4.0.0.

Rf_FixupDigits
Rf_FixupWidth

These RAPI entries were added to open-source R 4.0.0.

Rf_installNoTrChar
(See Rf_installTrChar.)

Rf_installTrChar
This RAPI entry has the same behavior as Rf_installChar. It
supports building and loading CRAN packages such as lfe that call
installChar, which expands to Rf_installTrChar, beginning with R
4.0.0.

Rf_log1mexp
This RAPI entry computes log(1-exp(-x)) for non-negative x with
minimal loss of precision.

Rf_onintr
This RAPI entry is fully implemented so it no longer produces a "not
implemented" warning. Now, the RAPI entry interrupts the current
evaluation. Interrupts created by a call to Rf_onintr, or by pressing an
interrupt key combination, are now processed through the condition
system, so they can be caught by tryCatch(...,interrupt=...).

SET_GROWABLE_BIT
IS_GROWABLE

These RAPI entries are required to load the readr package v1.4.0.

SETLEVELS
This RAPI entry is needed to load the qs package.

R_EvalSymbol
This R C API symbol is now exported so that packages using it can be
loaded into TERR.

Rf_PairToVectorList(SEXP
 pairlist)

This R C API entry converts a pairlist to a list.

R_Serialize
R_Unserialize

These R C API entries are called by the qs and RApiSerialize packages.
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R C API entries Description

R_InitOutPStream
R_InitInPStream

Changes in Functionality, Features, and Compatibility

Version 6.0 of TERR contains the following changes in functionality.

Changes in functionality and compatibility

Version 6.0 of TERR was tested with open-source R version 4.0.2. The following changes to functions in
TERR were made for compatibility with open-source R 4.0.2 or with Java 11.

Key Version Description

TERR-3052 6.0.0 file.rename is now vectorized to allow renaming multiple files at once. For example,

file.rename(file.path(tdir, c("File1", "File2")), file.path(
tdir, c("File1renamed", "File2renamed")))

TERR-7593 6.0.0 class(<matrix>) now returns c('matrix','array'), rather than 'array'. This
change was made to match the behavior new to R 4.0. S3 dispatching for matrix objects
now dispatch to both array and matrix methods. Also new in this release of TERR is the
function .class2(x), which returns the class names used for S3 method dispatching of
the object x.

TERR-7628 6.0.0 unlist(x,recursive=TRUE) now returns a factor when x is a multi-level list of factors
(for example, a list of list of factors).  Previously, it returned a factor only when x was a
1-level list of factors.  This changes matches the behavior that open-source R has had for
several releases.

TERR-7678 6.0.0 TERR now accepts raw string literals such as r'(abc)' to specify the string "abc".
 This change matches open-source R version 4.0, and it makes it easier to specify strings
containing single and double quotes and backslashes.

TERR-7733 6.0.0 The plot() function was moved from the graphics package to the base package. (A
copy is kept in the graphics package for backward compatibility.) This change was made
so you can define plot methods without first loading the graphics package. TERR has
implemented this change to match open-source R 4.0.

TERR-7744 6.0.0 The functions regexpr, gregexpr, and regexec functions now add the index.type and
useBytes attributes to their output. This change is to match open-source R behavior.

TERR-7756 6.0.0 The default value of options("stringsAsFactors") and  of default.
stringsAsFactors() is now FALSE instead of TRUE. This change affects how data.
frame(), read.table(), and other functions that create data.frames treat character
columns. This change follows the same change in R-4.0.0.

TERR-7764 6.0.0 TERR now treats Unicode characters according to the Unicode 8.0 standard, as opposed
to the Unicode 6.0 standard used by TERR 5.1.

TERR-7770 6.0.0 The C code function Rf_defineVar(sym,R_UnboundValue,env) now gives an error,
 rather than removing the variable from env. This change matches a change in R 4.0.0.

TERR-7778 6.0.0 The paste() function now includes the argument recycle0=FALSE, to match a change
made to R 4.0.1.

TIBCO® Enterprise Runtime for R Release Notes
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Key Version Description

TERR-7793 6.0.0 stopifnot( NOT_GOOD = 1 < 0) now prints the error message "NOT_GOOD" instead of
"1 < 0 is not TRUE".  stopifnot() also has a new argument, exprObject.  These
changes make stopifnot match the behavior of that function in version in R-4.0.0.

TERR-7794 6.0.0 The prop.table and margin.table functions have new preferred names: proportions
and marginSums.  Also, you can now use these functions, as well as the functions apply
and sweep, to specify the margins by name instead of only by number. (The names must
be in names(dimnames(x))).

TERR-7807 6.0.0 The recursive argument to tools::package_dependencies can now be a vector of
column names that specify which columns of available.packages to use for recursive
dependencies. Also, the which and recursive arguments can use the nicknames "
strong", "most", or "all" for commonly-used sets of column names.

TERR-7809 6.0.0 Changes to Java 11 caused a failure accessing TIBCO Spotfire® Statistics Services from
the parallel package running under TERR. Because of this issue, support for the parallel
package accessing Spotfire® Statistics Services is removed.

TERR-7810 6.0.0 The factor method for the c function has been implemented following a recent change
in open-source R. This method combines factor arguments into a new factor whose
levels attribute is the union of the levels attributes of the arguments. If all arguments are
ordered factors with identical levels, then it returns an ordered factor with those levels.

This change can break old code that used the c function on factors. Previously,
 c would strip the class and levels attributes and just combine the integer codes
of the factors.

TERR-7824 6.0.0 The command-line arguments -s and --no-echo have replaced the deprecated --slave
argument. This matches the behavior of open-source R 4.0.0.

TERR-7831 6.0.0 as.list(emptyenv(), sorted=TRUE) no longer gives an error in order(names(
retval)). as.list(emptyenv(), sorted=TRUE) now returns a nameless empty list, as
it always has when sorted is FALSE.

TERR-7834 6.0.0 If a package declares that it requires one C++ standard in both DESCRIPTION:
SystemRequirements and src/Makevars, then the package requirement from src/
Makevars is used. Previously, the one in DESCRIPTION was used, which caused problems
with some packages with mismatched entries.

TERR-7836 6.0.0 install.packages() now runs the configure and clean steps with TERR_LIBS set to
current value of .libPaths(). If the configuration script invokes TERR, then TERR can
access all of the same packages that the main process can access. With this change, you
can now install recent versions of packages such as prophet and other rstan-dependent
packages from source.

TERR-7844 6.0.0 TERR CMD Rscript now processes its command line arguments the same way that open-
source R does. In particular, TERR CMD Rscript -e "commandArgs(TRUE)" foo, now
prints "foo" instead of treating "foo" as an R-code file to execute.

On the TERR command line, you can no longer supply both the -f file and -e
expression arguments. You must choose to execute either a file or one or more in-line
expressions.

TERR-7845 6.0.0 Factors with duplicated levels are no longer allowed and now return an error instead of a
warning. This change matches behavior in open-source R 4.0.2.

TERR-7848 6.0.0 grid::unit() and grid::grob() no longer produce unimplemented function
warnings. They are not implemented, but they caused several warnings when TERR
loaded packages that imported the ggplot2 package. All of the other "unimplemented
function" warnings in the grid package have been changed to "unimplemented
graphics function" warnings.

TIBCO® Enterprise Runtime for R Release Notes
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Key Version Description

TERR-7850 6.0.0 The command line command TERR CMD SHILB code.cpp now assumes that code.cpp
adheres to the C++11 standard. To override this new behavior, in the file Makevars, use
CXX_STD=CXX??.

TERR-7853 6.0.0 sample.int(n, ...) can now accept n > .Machine$integer.max, with limitations.
 In the n > .Machine$integer.max case, the return value is a numeric (not an integer)
 or a vector (but all values are in 1, 2, ..., n). The limitations are that for such large n, one
cannot also supply the prob argument, and the sampling is only done with replacement (
the replace argument is silently ignored).

TERR-7858 6.0.0 utils::URLencode(URL,...) and utils:::URLdecode(URL) can now handle a vector
of URLs, not just a single URL.

TERR-7859 6.0.0 head(x,n) and tail(x,n), when x is an object with dimensions, allow n to be a vector
the length of dim(x), specifying how many slices of each dimension to return.

TERR-7865 6.0.0 Calling the function drop1() for glm models and with test="Chisq" could result in a
mislabeled test statistic column. Now, it labels the test statistic column as open-source R
4.0 does, using "LRT" when scale=1, or when family is specified as either binomial or
poisson and scale=0, and using "scaled dev." otherwise.

TERR-7866 6.0.0 Calling the function drop1 and specifying a poisson or binomial glm object, and with
test="F", now warns that the test is for a quasipoisson or quasibinomial model. (A
Chisq test would be more appropriate here.)

TERR-7872 6.0.0 packBits(x, type) now accepts type="double", which causes packBits to pack the
low order bit of each 64 elements of x into a double-precision numeric value. This is the
inverse of the new numToBits(x).

TERR-7877 6.0.0 If x is equal to the NULL object, then x[[1]] <- vector now always turns x into a list
with one entry: list(vector). Previously, the result depended on the length of vector:
 if the length was one, then x became a copy of vector; otherwise, x became list(
vector). In TERR 6.0, the result is independent of the length of vector. This behavior is
more consistent and follows the same change in open-source R 4.0.0.

TERR-7889 6.0.0 The R C API function R_ReleaseObject(extPtr) no longer warns if extPtr had
not been protected by a previous call to R_Preserver(extPtr). This change stops
unwarranted warnings from code using the xml2 package.

Additionally, the value of the repos option now includes a URL for the MRAN repository. The default
date used in the MRAN URL is based on the TERR build year, month, and day. The order of precedence
for installation of packages is now TRAN, MRAN, and CRAN.

Other version updates for TERR 6.0.0

For information about updates in version 6.0.1, see Third Party Software Updates on page
10.

Version updates and version compatibility testing include the following.

● OpenSSL updated to version 1.1.1g (Included with TERR).

● Tested with JAVA version 11; however, any compatible version of Java can be used.

● open-source R version 4.0.2.

● RStudio Desktop and Server version  1.3.1093. For more information, see Configuring RStudio to use
TIBCO® Enterprise Runtime for R in the TERR documentation.

TIBCO® Enterprise Runtime for R Release Notes
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TERR is no longer tested with Spark, KNIME, or Hadoop. See the TERR articles on the TIBCO
Community site for more information about using these tools.

The following packages included with TERR require a bit-matching 32-bit or 64-bit version Java.

● parallel

● sjdbc

● terrJava

Additionally, if you want to use the rJava package, or any other CRAN package that requires
access to JAVA_HOME, this information applies.

To use these packages, you must set the JAVA_HOME environment variable to a valid Java installation
before you load the packages. You can set JAVA_HOME using TERR by calling the following in the
console:

Sys.setenv(JAVA_HOME="path_to_your_JRE_installation")

To check if the environment variable is set, call the following in the console:

Sys.getenv("JAVA_HOME")

As of TERR version 4.1, for Windows installations, if the JAVA_HOME environment variable is not
set, TERR uses system info to identify and load the latest Java installed on the system.

Deprecated and Removed Features

Version 6.0 of TERR has deprecated or removed the following features.

TERR 6.0.1

Deprecated
Version 6.0.1 of TERR has no deprecated features.

Removed
Version 6.0.1 of TERR has removed no features.

TERR 6.0.0

Deprecated
As of version 6.0.0, TERR is deprecated on macOS and is no longer tested.

Removed
As of version 6.0.0 of TERR, support for the following features is removed.
The --slave command-line argument has been removed. It is replace by the command-line
arguments -s and --no-echo. This change matches the behavior of open-source R 4.0.0.
Support for the parallel package accessing TIBCO Spotfire Statistics Services has been
removed. The TERR function makeTSSScluster has been removed, and the function
makeCluster(type="TSSS",...) gives an error.
The Developer Edition of TIBCO® Enterprise Runtime for R is no longer available on the TAP site. For
a trial version of TERR, see its entry on the TIBCO edelivery site.

Third Party Software Updates

Version 6.0 of TERR contains the following third-party software updates.

TIBCO® Enterprise Runtime for R Release Notes
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Key Version Summary

TERR-7961 6.0.1 curl updated to 7.84.0

TERR-7962 6.0.1 Libarchive updated to 3.6.1. (This library is used for the .tar executable in the TERR
bin directory.)

TERR-7963 6.0.1 GNOME Libxml2 updated to 2.9.14

TERR-7964 6.0.1 zlib updated to 1.2.12

TERR-7965 6.0.1 This release includes a patch from International Components for Unicode (ICU) that
remediates CVE-2020-10531.

TERR-7966 6.0.1 OpenSSL updated to 1.1.1q

TERR-7967 6.0.1 This release includes patches from Debian that remediate CVE-2018-1000035, CVE-
2019-13232, CVE-2022-0529, and CVE-2022-0530. 

TERR-7969 6.0.1 Olson time zone database updated to 2022a.

Package Compatibility

As a standard part of each TERR release, we run all help examples provided in packages in the
Comprehensive R Archive Network (CRAN) in the TERR engine from the Windows and Linux
platforms.

Beginning with release 5.1, we also run all help examples provided in packages in the Bioconductor
(BIOC) list.

Package loading improvements

● To see a list of issues fixed to improve package loading and performance, see Closed Issues.

● To see a list of Rapi C API functions and TERR functions implemented in this release to improve
package loading and performance, see New features.

● To see a complete listing of the Rapi C API functions implemented in TERR so far, run the following
code.

library(terrUtils)
implementedRapiEntries()

Package compatibility analysis in Spotfire

We report the results of these tests in visualizations that are available on TIBCO Cloud™ Spotfire® at
the following links. You can browse and review the results for the packages you want to use and their
Task Views. You can review the results run for every expression in every help file for every CRAN
package or BioConductor package for the following platforms.

CRAN packages BioConductor packages

Windows Windows

Linux Linux

TIBCO® Enterprise Runtime for R Release Notes
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The tests run against code examples in the help provide some guidance for determining rates of
success. The accuracy of information collected depends on the number and quality of examples in
the package reference topics. These analyses are not meant to be the definitive determination of exact
compatibility.

For more information about CRAN packages, see https://cran.r-project.org/web/packages/

● For more information about BioConductor packages, see https://www.bioconductor.org/packages/
release/bioc/

TIBCO does not warrant, deliver, or support code or other material provided by the R Project
for Statistical Computing, including but not limited to development tools and packages, and
such code and other material does not constitute a part of TERR. Such material therefore is not
within the scope of your license for TERR. Download and use of such material is solely at your
own discretion and subject to the free open source license terms applicable to such material.
TIBCO recommends that you consult a legal professional concerning compliance with any free
open source license terms applicable to such material, particularly if you plan to engage in
redistribution of TERR and/or such material. (Please note that TERR may be redistributed solely
pursuant to a license that expressly grants such redistribution rights.)

Package compatibility summary in TERR

Alternatively, we provide a summary of our testing results on the TIBCO documentation site in the
following CSV-formatted files.

● CRANonTERR-Linux.csv

● CRANonTERR-Win.csv

● BIOConTERR-Linux.csv

● BIOConTERR-Win.csv

TERR console code example for CRAN
You can use the TERR console to quickly access a summary of the information. The following example
returns the results for testing the help files for the CRAN package caret. You can change the example
to match the platform and package of your choice.

1. Change the CSV file name to match the platform (Linux or Windows).
2. Remove the comment markers for the CSV file name.
3. Provide the name of the package you want to query.

# Example:  CRAN tests compatibility with this version of TERR
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.0.1/doc/
csv/CRANonTERR-Linux.csv", 
#   stringsAsFactors=FALSE)
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.0.1/doc/
csv/CRANonTERR-Win.csv", 
#   stringsAsFactors=FALSE)
#
subset(packageCompat, Package.Name=="caret")
## (update)

The returned results resemble the following for the above example.

    Package.Name Version            Status Percent.Successful Total.Executed
1608        caret  6.0-86 Mostly successful                98.5%            205
    Passed Failed Graphics Random.Numbers
1608    202      3       17             100
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This table shows how to read the results for this example. (Shows sample results for running the
example on Linux. Results for Windows can vary slightly.)

Column name Result

Package.Name caret

Version 6.0-86

Status Mostly successful

Percent.Successful 98.5%

Total.Executed 205

Passed 202

Failed 3

Graphics 17

Random.Numbers 100

TERR console code example for BioConductor
You can use the TERR console to quickly access a summary of the information. The following example
returns the results for testing the help files for the BioConductor package limma. You can change the
example to match the platform and package of your choice.

1. Change the CSV file name to match the platform (Linux or Windows).
2. Remove the comment markers for the CSV file name.
3. Provide the name of the package you want to query.

# Example:  BioConductor tests compatibility with this version of TERR
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.0.1/doc/
csv/BioConTERR-Linux.csv", 
#   stringsAsFactors=FALSE)
#
#packageCompat <- read.csv("https://docs.tibco.com/pub/enterprise-runtime-for-R/6.0.1/doc/
csv/BioConTERR-Win.csv", 
#   stringsAsFactors=FALSE)
#
subset(packageCompat, Package.Name=="limma")
## (update)

The returned results resemble the following for the above example.

Package.Name Version            Status Percent.Successful Total.Executed
901        limma  3.44.3 Mostly successful               96.9            391
    Passed Failed Graphics Random.Numbers
901    379     12       49             75

This table shows how to read the results for this example. (Shows sample results for running the
example on Linux. Results for Windows can vary slightly.)

Column name Result

Package.Name limma

Version 3.44.3

TIBCO® Enterprise Runtime for R Release Notes
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Column name Result

Status Mostly successful

Percent.Successful 96.9%

Total.Executed 391

Passed 379

Failed 12

Graphics 49

Random.Numbers 75

Update or Reinstall a Version of TERR

When you update to a more recent version of TERR, remove the previous version, and follow the
guidelines to protect your installed packages.

Installing TERR over a previous TERR installation without removing it can cause unexpected
failures. To remove TERR, follow the instructions for your operating system.

For a list of operating systems that TERR is supported on, see the TIBCO Enterprise Runtime for
R system requirements.

When you update to a new version of TERR, follow the guidance in "Package installation locations and
recommendations for updating" in the Package Management section of the TIBCO® Enterprise Runtime
for R Technical Documentation.

On Linux

● From the command line, run the command rm -rf <TERR_HOME>, where TERR_HOME is the
installation directory.

On Mac

● At the Terminal command prompt, run the following commands.

sudo rm -rf /Library/Frameworks/TERR.framework /usr/local/bin/TERR /usr/local/bin/
TERRscript /usr/local/bin/RStudio-TERR

As of version 6.0, TERR is deprecated on macOS and is no longer tested.

If you are prompted to supply a password, provide the administrator password for the
computer.

The following three specified items are removed.

● The TERR framework package.

● Scripts for running TERR.

● A script to launch RStudio running TERR.
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On Windows

● From the Settings app, click Apps, and then from the Apps & features list, double-click run the
listing TIBCO Enterprise Runtime for R <version#>.

After uninstalling TERR, run the installer for the version of TERR you want to install.

Closed Issues

Version 6.0 of TERR contains the following closed issues.

Key Version Description

TERR-7944 6.0.1 If the system environment variable to R_HOME is set before starting Spotfire, then the
menu option TERR Tools > Launch RStudio IDE fails the first time with the error :

Item has already been added. Key in dictionary: 'R_HOME' Key
 being added: 'R_HOME' 

and then subsequent times with the following error:

Cannot create a file when that file already exists.

TERR-7968 6.0.1 If you call buildServerSPK or buildSPK from the SpotfireSPK package with the repos
and buildDir options specified, then the function call can fail with the following error. 

The process cannot access the file because it is being used by
 another process. 

TERR-6032 6.0.1 In certain scenarios, using the parallel package could result in orphan java processes
that are not shut down correctly. These processes consume resources after the script is
executed.

TERR-3978 6.0.0 seq.POSIXt(from=date1, to=date2, by=...) outputs dates beyond date2.

TERR-5136 6.0.0 A long input line in the console can cause TERR to fail unexpectedly.

TERR-5176 6.0.0 Printing the summary of a Date or a POSIXct or POSIXlt vector with NAs or with a data.
frame that contains a column of these types does not print the number of NAs correctly.

TERR-5689 6.0.0 Setting row names for an xts object from the xts package results in the error invalid '
dimnames' given for xts.

TERR-6073 6.0.0 The regmatches function does not work correctly when its invert argument is NA.

TERR-6114 6.0.0 summary.Date, summary.POSIXct, and summary.POSIXlt stores the number of NAs as a
Date instead of an integer. This behavior does not match open-source R.

TERR-6977 6.0.0 system2 ignores input and stdin arguments on Linux.

TERR-7004 6.0.0 An update to the MK library in TERR 4.5.0 can cause slight differences from nls()
 compared to earlier versions.

TIBCO® Enterprise Runtime for R Release Notes
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Key Version Description

TERR-7044 6.0.0 The source() function does no accept arguments that were added to open-source R:

● exprs

● spaced

● width.cutoff

● deparseCtrl

TERR-7087 6.0.0 system2() returns incorrect results if there are over a certain number of characters in the
command line.

TERR-7122 6.0.0 read.table gives an error when reading a space character as a logical.

TERR-7217 6.0.0 seq.Date and seq.POSIXt does not accept specifying the time unit as by="quarters".

TERR-7508 6.0.0 When you initialize an S4 object with a slot of class vector, or set this slot with slot(
obj,nm,check=TRUE)<-newval, the new slot value is not coerced to a vector before it is
assigned.

TERR-7696 6.0.0 In some obscure cases, calling eval on an expression can generate an error before the
expression started evaluation.

TERR-7702 6.0.0 The function setMethod does not match R's behavior when it generates warnings or
messages about unknown classes in the method signature. Specifically, no message or
warning is generated if an unknown class is specified with a className object.

TERR-7707 6.0.0 The setRefClass function does not correctly set the slots and prototype of the refclass,
 including information from any non-refclass superclasses.

TERR-7713 6.0.0 ts(x=matrix(), names=NULL) does not set the column names of the output to NULL;
 rather it sets "Series <n>" or to the column names of x. The formatting and printing
functions for such objects convert NULL column names to "Series <n>".

TERR-7719 6.0.0 sprintf("%.0f", c(Inf,-Inf,NA,NaN)) truncates the result to zero characters. It does
not ignore the precision part of the format specifier when rendering special numeric
values. This behavior does not match that of open-source R.

TERR-7726 6.0.0 seq.POSIXt(from,to,by) can give an extra element beyond the desired sequence of
times, depending on the current time zone.

TERR-7731 6.0.0 TERR does not allow collecting errors generated within internal OpenMP code (which
can lead to errors such as "Error: invalid comparison with complex values (600
times in omp region)").

TERR-7738 6.0.0 An incorrect error message can be printed when there was a tryCatch call within an on.
exit expression.

TERR-7739 6.0.0 Making a data.frame from a recursive list sometimes drops some parts of the resulting
column names.

TERR-7741 6.0.0 The exclude and useNA arguments to table() do not work properly in several ways. For
example, exclude=NULL has the side effect of setting useNA to "always". Also, factor(
exclude=NA, x) excludes both NA and NaN from the levels of the resulting factor.

TERR-7743 6.0.0 The real(), is.real(), and as.real() functions are still in TERR. They were removed
from open-source R in 2013.
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Key Version Description

TERR-7747 6.0.0 When printing a list containing classed objects or an object with classed attributes, the
print method for those classed objects do not get exactly the arguments passed to print:
 some arguments are omitted and some are added.

TERR-7748 6.0.0 The function as.hexmode("") returns 0 instead of giving an error, as is done in open-
source R 3.6.0.

TERR-7750 6.0.0 array(x,dim,dimnames) ignores non-list dimnames, which differs from behavior in open-
source R 3.3.0, where array(x,dim,dimnames) requires that dimnames be a list (or
pairlist).

TERR-7754 6.0.0 The functions suppressMessages and suppressWarnings do not include the argument
classes. This argument is used for suppressing only certain classes of messages or
warnings.

TERR-7757 6.0.0 transform.data.frame() does not pass arguments to data.frame(). For example, it
does not pass stringsAsFactors and check.names to data.frame(), but treats them like
new columns in the data.frame it produces.

TERR-7760 6.0.0 The summary method for lm objects does not return the weights component from the lm
object. if it exists.

TERR-7774 6.0.0 The normalizePath function on Windows does not return the capitalization used in the "
official" version of the file name.  Rather, the capitalization depends on context.

TERR-7777 6.0.0 If you manually edit the DCF created by a call to buildServerSPK, and then rebuild the
SPK from the DCF without explicitly providing a value for the spkName argument, then the
function can fail with an error.

TERR-7789 6.0.0 TERR processing an interrupt does not match open-source R, which defines a restart
named "resume". In R, if the function withCallingHandlers defines an interrupt
condition handler that invokes this restart, the interrupted computation is resumed.

TERR-7790 6.0.0 The options('interrupt') does not match open-source R, where if it is set to a function,
 it is called with no arguments if an interrupt condition is not caught. In R, if this function
invokes a restart named "resume", then the interrupted computation is resumed.

TERR-7795 6.0.0 The argument matching with ... and default values do not match open-source R. Also,
 the lapply and other apply functions do not ignore extra missing arguments specified
using 'a,i=,b', which also does not match open-source R.

TERR-7800 6.0.0 The unexported function utils:::checkHT is not defined so that the code in the Matrix
package cannot call it. The function do.call('[',argList) does not work correctly if
argList contains missing values for the selection indices.

TERR-7804 6.0.0 In open-source R 4.0.0, S3 method dispatching for cbind and rbind has changed, so it calls
the cbind or rbind S3 method for the first argument that has one, rather than using the
default cbind or rbind if multiple arguments have different S3 methods, as TERR does.

TERR-7823 6.0.0 A C function called with .Call returns the C NULL value but not generate a warning.

TERR-7825 6.0.0 On Windows, file.rename(aa,bb) fails if the file bb already exists.

TERR-7828 6.0.0 Several selection and replacement functions defined as TERR natives (such as storage.
mode, `$`, `[<-`, and so on) do not return the correct arguments when passed to the args
and formals functions.

TERR-7833 6.0.0 contrib.url(type="mac.binary") adds the nickname of a MacOS version in the
returned URL.
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Key Version Description

TERR-7843 6.0.0 TERR does not correctly handle CTRL+C interrupts in non-interactive sessions, such as
when TERR is started with the options -e, -f, or < file, or when TERR is run in Emacs/
ESS.

TERR-7852 6.0.0 The R C API function VECTOR_ELT(x,i) does not accept i up to max(TRUELENGTH(x)
,length(x))-1, but just to length(x)-1, which is needed for the data.table package,
 version 1.13.0, to work in TERR.

TERR-7854 6.0.0 The Rapi entries TAG and SET_TAG do not allow an object to be the 'tag' of a pairlist, rather
than giving an error. The Rapi entry R_UnwindProtect gives an error "bad continuation
argument". These cause problems using the vroom and cpp11 packages.

TERR-7864 6.0.0 base::OlsonNames() contans a small memory leak.

TERR-7876 6.0.0 The Rapi entries CAR, CDR, and TAG do not work on function objects. The corresponding
entries for setting (SETCAR, SETCDR, and SET_TAG) also do not work on function objects. (
These entries are called by the qs package.)

TERR-7891 6.0.0 With the curl package, when you call Rf_error while executing a R_new_custom_
connection callback method, TERR can close unexpectedly.

TERR-7893 6.0.0 as.POSIXct("2029-02-29 14:17",format="%Y-%m-%d %H:%M") does not return NA,
 rather than returning 2029-03-01. 

TERR-7894 6.0.0 stats::reformulate() does not have the argument env=parent.frame() so you could
make the environment of the returned formula whatever you want it to be.

TERR-7895 6.0.0 regmatches(x, invert=TRUE, ...) and regmatches(x, invert=NA, ...) give the
error "missing value where TRUE/FALSE needed" when x contained an NA.

TERR-7906 6.0.0 When utils::unzip has problems unzipping a file when used with install.packages
(for example), it does not give an error message containing details about the error. Errors
are printed to the standard error stream and are not part of the error message itself.

TERR-7923 6.0.0 When functions like readLines read UTF-8 characters, they skip illegal Unicode
characters (such as 0xFFFD) with a warning, where they should read them as a character
(for example, the character 0xFFFD). This does not permit loading the package jsonld,
 which reads a long js script including 0xFFFD characters.

TERR-7930 6.0.0 System Requirements does not reflect required library installation for running the TERR
console on RHEL 8, CentOS 8, and SUSE 15.

Known Issues

Version 6.0 of TERR contains the following known issues.

In this release, some open-source R functionality is not available, including graphics devices, and some
functions from the base and stats packages. Likewise, S4 is not entirely compatible. The following table
lists additional known issues.

Issue Description

TERR-4993 On Linux, you cannot save TERR Command History to a file.

TERR-5488 If you receive the message "SSL certificate problem: unable to get local issuer certificate"
 when accessing SSL protected URLs (for example, https://), make sure that your system has the latest
version of the certificate authority database for your system. On RedHat 5, this should be `yum update
openssl`. On RedHat 6, this should be `yum update ca-certificates`.
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Issue Description

TERR-6422 Setting breakpoints in RStudio 0.99.903 with TERR on Windows can cause it to crash. When a script is
sourced, and if it has breakpoints set, RStudio for Windows can crash. This crash does not occur when
breakpoints are set inside a function and the function is called.

TERR-6576 If you try to use an RStudio feature that requires the rmarkdown package or the shiny package, and the
required package is not already installed, then this process currently fails if RStudio is configured with
the TERR engine. To work around this problem, at the command prompt, call install.packages() to
install the rmarkdown and shiny packages.

TERR-6812 Due to changes in open-source R version 3.5 and resulting compatibility changes in TERR 5.0, packages
that are built with a version of TERR prior to 5.0 must be rebuilt.

● To install a binary package from a repository, always call install.packages(pkgname) from TERR.
 The install.packages function finds the correct binary version in the repository for your version
of TERR. Manually downloading the binary package from CRAN can result in errors when you use it
with TERR.

● To install a package from source, try installing it first with TERR (with install.packages in TERR or
with TERR CMD INSTALL from a command line).

● To install a package from source that you cannot build with TERR, install the package with the
version of open-source R tested with TERR.

TERR-7077 Certain packages, such as rJava, cannot be installed with TERR from source under Centos. If you
encounter a package that does not install with TERR from source, then you can build the package using
open-source R, and then install the binary package in TERR.

TERR-7727 When you view help files in Rstudio, some text in the help (for example, the Arguments and the Value
sections) might not be visible if you are using an Rstudio Editor theme with a dark background.

TERR-7728 When you run TERR under Rstudio Server, if you end the session using File > Quit Session, the following
message is displayed: Session Error, The previous R session was abnormally terminated due
to an unexpected crash. This problem can also occur when you open a project using the File > New
Project or File > Open Project menu commands.

Package search order

When you install a package using TERR, by default, TERR first checks for the package on TRAN, and
then checks on MRAN. TERR installs the first version it finds. This is different than open-source R,
which installs packages according to the newest version number available on CRAN. This difference is
by design, because occasionally a CRAN package update causes a break with TERR compatibility, so
we make available a tested version of the package on TRAN.

If you need to install one of these packages using open-source R (for example, to get source code on
Linux), you can install the CRAN package, and then set options()$repos to install from only TRAN
before reinstalling the package.

See "Specifying an older package on TRAN" in the TIBCO® Enterprise Runtime for R Technical
Documentation for more information.

When running on RedHat Linux, TIBCO Enterprise Runtime for R processes spawned by the
parallel package may immediately crash

We have seen a problem when running TERR on RedHat Linux with versions of Java earlier than
1.7.0_40. If you call the makeCluster function in the parallel package to spawn new TERR processes,
these processes may immediately crash with a fatal Java error. To test if this problem is occurring, try
the following:

library(parallel)
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c1 <- makeCluster(1, outfile="")
# create cluster with one spawned process
# specifying outfile="" to print all output
c1 <- makeCluster(1, outfile="")
clusterEvalQ(c1, 123)

If this problem is occurring, you see an error such as the following:

> library(parallel)
> # create cluster with one spawned process
> # specifying outfile="" to print all output from the process
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Thu Aug 20 11:31:25 2020
> clusterEvalQ(c1, 123)
1: #
1: # A fatal error has been detected by the Java Runtime Environment:
1: #
1: # SIGSEGV (0xb) at pc=0x0000003ac2cbbfa5, pid=12649, tid=1075054912
1: #1: # JRE version: 7.0_13-b20
1: # Java VM: Java HotSpot(TM) 64-Bit Server VM (23.7-b01 mixed mode linux-amd64 
compressed oops)
1: # Problematic frame:
1: # C [libstdc++.so.6+0xbbfa5) __cxa_allocate_exception+0x55
1: #
1: # Failed to write core dump. Core dumps have been disabled. To enable core 
dumping, try "ulimit -c unlimited" before starting Java again
1: #
1: # An error report file with more information is saved as:
1: # /a/seafiler01.na.tibco.com/vol/vol2/users/jdoe/hs_err_pid12649.log
1: #
1: # If you would like to submit a bug report, please visit:
1: # http://bugreport.sun.com/bugreport/crash.jsp
1: #
Error in waitForClusterReady(cl) : some cluster nodes have crashed or stopped: all crashed

The workaround for this problem is to set the LD_PRELOAD environment variable to libstdc++.so.6.
This can be done before TERR is started, or within TERR, before the parallel library has been loaded:

> Sys.setenv("LD_PRELOAD"="libstdc++.so.6")
> library(parallel)
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Thu Aug 20 11:32:56 2020
> # create cluster with one spawned process
> # specifying outfile="" to print all output
> c1 <- makeCluster(1, outfile="")
Creating 1 TERR cluster nodes at Thu Aug 20 11:33:51 2020
> clusterEvalQ(c1, 123)
1: TIBCO Software Inc. Confidential Information
1: Copyright (C) 2011-2020 TIBCO Software Inc. ALL RIGHTS RESERVED
1: TIBCO Enterprise Runtime for R version 6.0.0 for Microsoft Windows 64-bit
1:
1: Type 'help()' for help.
1: Type 'q()' to quit.
1: started engine node pid==15788 at Thu Aug 20 11:33:54 2020
[[1]]
[1] 123
>
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Documentation and support services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation website, mainly
in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than any
other documentation included with the product. To access the latest documentation, visit https://
docs.tibco.com.

System Requirements for Spotfire Products

For information about the system requirements for Spotfire products, visit http://spotfi.re/sr.

TIBCO Enterprise Runtime for R documentation

You can find the following documents for TIBCO Enterprise Runtime for R in the TIBCO
Documentation Library.

● TIBCO® Enterprise Runtime for R Technical Documentation

● Language Reference (HTML)

● Differences Between TIBCO® Enterprise Runtime for R and Open-Source R (HTML)

● Release Notes (PDF)

● License Agreement (PDF)

You can also find links to CRAN package compatibility reports for this release on TIBCO Cloud™

Spotfire®. See links in the TERR Release Notes for more information.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

● For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

● For accessing the Support Knowledge Base and getting personalized content about products you are
interested in, visit the TIBCO Support portal at https://support.tibco.com.

● For creating a Support case, you must have a valid maintenance or support contract with TIBCO.
You also need a user name and password to log in to https://support.tibco.com. If you do not have a
user name, you can request one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee subject matter
experts to share and access their collective experience. TIBCO Community offers access to Q&A forums,
product wikis, and best practices. It also offers access to extensions, adapters, solution accelerators, and
tools that extend and enable customers to gain full value from TIBCO products. In addition, users can
submit and vote on feature requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

For quick access to the TIBCO® Enterprise Runtime for R content, see https://community.tibco.com/
products/terr.
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Legal and Third-Party Notices

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY
(OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE
FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END
USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this document
may be reproduced in any form without the written authorization of TIBCO Software Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, TIBCO Spotfire, TIBCO Spotfire Analyst, TIBCO Spotfire
Automation Services, TIBCO Spotfire Server, TIBCO Spotfire Web Player, TIBCO Enterprise Runtime
for R, TIBCO Enterprise Runtime for R - Server Edition, TERR, TERR Server Edition, and TIBCO
Spotfire Statistics Services are either registered trademarks or trademarks of TIBCO Software Inc. in the
United States and/or other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme.txt file for the
availability of this software version on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S) AND/
OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY
OR INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of TIBCO Software Inc. may be covered by registered patents. Please refer to
TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1994-2022. TIBCO Software Inc. All Rights Reserved.
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